Cisco Active Network Abstraction
Customization User Guide
Version 3.5.2

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO
CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS
MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY
PRODUCTS.

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
  800 553-NETS (6387)
Fax: 408 527-0883

Text Part Number: OL-12149-01
Preface vii

Preliminary Knowledge Required for Using This Guide viii

Related Documentation viii

Obtaining Documentation viii

Cisco.com viii

Product Documentation DVD viii

Ordering Documentation ix

Documentation Feedback ix

Cisco Product Security Overview ix

Reporting Security Problems in Cisco Products x

Product Alerts and Field Notices x

Obtaining Technical Assistance xi

Cisco Support Website xi

Submitting a Service Request xii

Definitions of Service Request Severity xii

Obtaining Additional Publications and Information xii

CHAPTER 1 Introducing the Cisco ANA Soft Properties Manager 1-1

About the Soft Properties Manager 1-1

Soft Properties 1-2

Alarm Thresholds 1-2

Basic Concepts and Terms 1-2

CHAPTER 2 Getting Started 2-1

Opening the Soft Properties Manager 2-2

Soft Properties Manager Window 2-3

Properties Panel 2-4

Element Properties Table 2-4

Soft Properties Manager Menu Bar 2-5

Soft Properties File Menu 2-5

Soft Properties Tools Menu 2-5

Soft Properties Toolbar 2-5
Soft Properties Manager Workflow 2-6
Creating or Editing a Soft Property 2-8
   Editing a Soft Property 2-8
Defining the General Parameters 2-9
Defining the Parsing Parameters 2-10
   Defining the Parsing Parameters of a Soft Property Table 2-14
Testing the Parsing Rules 2-15
Defining the TCA Alarms Parameters 2-16
Debugging the Soft Property 2-18
Viewing the Soft Property in the Inventory Window 2-19
Publishing the Soft Property 2-19
Deleting a Soft Property 2-22
Importing and Exporting a Soft Property 2-22
Closing the Soft Properties Manager 2-23

CHAPTER 3

Examples 3-1
   Basic Soft Property Example 3-1
   Soft Property Example Including TCA Alarm 3-8
   Soft Property Table Example 3-10

APPENDIX A

Parsing Operators/Rules A-1
   Header and Footer A-1
      Description A-1
      Dialog Box A-2
      Parameters A-2
   Remove Lines A-2
      Description A-2
      Dialog Box A-3
      Parameters A-3
   Select Lines A-3
      Description A-3
      Dialog Box A-4
      Parameters A-4
   Replace A-4
      Description A-4
      Dialog Box A-5
      Parameters A-5
Contents

Match A-6
   Description A-6
   Dialog Box A-6
   Parameters A-6

Set A-7
   Description A-7
   Dialog Box A-7
   Parameters A-7

Substring A-8
   Description A-8
   Dialog Box A-8
   Parameters A-8

Parse Integer A-9
   Description A-9
   Dialog Box A-9
   Parameters A-9

APPENDIX B

Alarm Threshold Triggers B-1
   Value Equal B-1
   Value Not Equal B-2
   Upper Threshold B-2
   Lower Threshold B-3
   Upper Rate B-4
   Lower Rate B-5

APPENDIX C

Regular Expressions C-1
   Supported Syntax C-1
      Positional Operators C-1
      One-Character Operators C-1
      Character Class Operator C-2
      Branching (Alternation) Operator C-2
      Repeating Operators C-3
      Stingy (Minimal) Matching C-3
      Lookahead C-3
   Unsupported Syntax C-3
Preface

This Cisco ANA Customization Guide describes managing soft properties and Threshold Crossing Alarms (TCA). Soft properties enable the user to extend the set of supported properties for each Network Element (NE), by adding soft properties to the Virtual Network Elements (VNEs). These properties extend the Cisco IMO and are available through the client GUI as well as through the BQL API. Soft properties are retrieved from the NE using SNMP, or Telnet/SSH. In addition, alarm thresholding enables the user to constantly monitor selected properties and generate an alarm every time they cross a user-defined threshold or violate a condition.

This guide is intended for use by integrators and any other users who want to manage the soft properties and TCA alarms that are executed within the Cisco Active Network Abstraction (ANA) platform.

It includes the following chapters:

- **Chapter 1, “Introducing the Cisco ANA Soft Properties Manager”**—Describes the Cisco ANA Soft Properties Manager. In addition, it provides a brief explanation of the terms soft properties and alarm thresholds used throughout this guide.

- **Chapter 2, “Getting Started”**—Describes the Soft Properties Manager’s working environment and how to access the Soft Properties Manager’s tools. In addition, it describes how to create, edit and delete a soft property.

- **Chapter 3, “Examples”**—Provides several examples of creating a soft property from start to finish, including defining the TCA alarms and defining a soft property table.

- **Appendix A, “Parsing Operators/Rules”**—Describes the pre-defined text manipulation operators available for parsing raw device input and turning it into a soft property. In addition, an example of each operator is provided.

- **Appendix B, “Alarm Threshold Triggers”**—Describes the pre-defined alarm threshold triggers available for defining TCA alarms.

- **Appendix C, “Regular Expressions”**—Describes the package GNU RegExp containing regular expression consists of a character string, where some characters are given special meaning with regard to pattern matching.

---

**Note**

Changes to the registry should only be carried out with the support of Cisco Professional Services.
Preliminary Knowledge Required for Using This Guide

The user of the Soft Properties Manager is required to have the following preliminary knowledge before using this tool:

<table>
<thead>
<tr>
<th>Subject</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Networking, device properties</td>
<td>Knowledge of device property retrieval using Telnet/SSH or a SNMP MIB browser.</td>
</tr>
<tr>
<td>Data manipulation</td>
<td>Ability to write regular expressions and parse raw strings using basic parsing tools.</td>
</tr>
<tr>
<td>Cisco IMO Types</td>
<td>Understanding of the Cisco ANA information model in order to know where to locate/edit the soft property.</td>
</tr>
</tbody>
</table>

Related Documentation

For more detailed information, refer to the following publications:

- Cisco Active Network Abstraction Command Builder User Guide
- Cisco Active Network Abstraction NetworkVision User Guide

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. This section explains the product documentation resources that Cisco offers.

Cisco.com

You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:


Product Documentation DVD

The Product Documentation DVD is a library of technical product documentation on a portable medium. The DVD enables you to access installation, configuration, and command guides for Cisco hardware and software products. With the DVD, you have access to the HTML documentation and some of the PDF files found on the Cisco website at this URL:

http://www.cisco.com/univercd/home/home.htm
The Product Documentation DVD is created and released regularly. DVDs are available singly or by subscription. Registered Cisco.com users can order a Product Documentation DVD (product number DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at the Product Documentation Store at this URL:

http://www.cisco.com/go/marketplace/docstore

Ordering Documentation

You must be a registered Cisco.com user to access Cisco Marketplace. Registered users may order Cisco documentation at the Product Documentation Store at this URL:

http://www.cisco.com/go/marketplace/docstore

If you do not have a user ID or password, you can register at this URL:


Documentation Feedback

You can provide feedback about Cisco technical documentation on the Cisco Support site area by entering your comments in the feedback form available in every online document.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:


From this site, you will find information about how to do the following:

- Report security vulnerabilities in Cisco products
- Obtain assistance with security incidents that involve Cisco products
- Register to receive security information from Cisco

A current list of security advisories, security notices, and security responses for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

 Reporting Security Problems in Cisco Products

Cisco is committed to delivering secure products. We test our products internally before we release them, and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability in a Cisco product, contact PSIRT:

- For emergencies only—security-alert@cisco.com
  An emergency is either a condition in which a system is under active attack or a condition for which a severe and urgent security vulnerability should be reported. All other conditions are considered nonemergencies.
- For nonemergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

- 1 877 228-7302
- 1 408 525-6532

Tip
We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been encrypted with PGP versions 2.x through 9.x.

Never use a revoked encryption key or an expired encryption key. The correct public key to use in your correspondence with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page at this URL:


The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT to find other means of encrypting the data before sending any sensitive material.

 Product Alerts and Field Notices

Modifications to or updates about Cisco products are announced in Cisco Product Alerts and Cisco Field Notices. You can receive these announcements by using the Product Alert Tool on Cisco.com. This tool enables you to create a profile and choose those products for which you want to receive information.

To access the Product Alert Tool, you must be a registered Cisco.com user. Registered users can access the tool at this URL:


To register as a Cisco.com user, go to this URL:

Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco Support website on Cisco.com features extensive online support resources. In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) engineers provide telephone support. If you do not have a valid Cisco service contract, contact your reseller.

Cisco Support Website

The Cisco Support website provides online documents and tools for troubleshooting and resolving technical issues with Cisco products and technologies. The website is available 24 hours a day at this URL:


Access to all tools on the Cisco Support website requires a Cisco.com user ID and password. If you have a valid service contract but do not have a user ID or password, you can register at this URL:


Note

Before you submit a request for service online or by phone, use the Cisco Product Identification Tool to locate your product serial number. You can access this tool from the Cisco Support website by clicking the Get Tools & Resources link, clicking the All Tools (A-Z) tab, and then choosing Cisco Product Identification Tool from the alphabetical list. This tool offers three search options: by product ID or model name; by tree view; or, for certain products, by copying and pasting show command output. Search results show an illustration of your product with the serial number label location highlighted. Locate the serial number label on your product and record the information before placing a service call.

Tip

Displaying and Searching on Cisco.com

If you suspect that the browser is not refreshing a web page, force the browser to update the web page by holding down the Ctrl key while pressing F5.

To find technical information, narrow your search to look in technical documentation, not the entire Cisco.com website. After using the Search box on the Cisco.com home page, click the Advanced Search link next to the Search box on the resulting page and then click the Technical Support & Documentation radio button.

To provide feedback about the Cisco.com website or a particular technical document, click Contacts & Feedback at the top of any Cisco.com web page.
Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and S4 service requests are those in which your network is minimally impaired or for which you require product information.) After you describe your situation, the TAC Service Request Tool provides recommended solutions. If your issue is not resolved using the recommended resources, your service request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone. (S1 or S2 service requests are those in which your production network is down or severely degraded.) Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411
Australia: 1 800 805 227
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity definitions.

Severity 1 (S1)—An existing network is “down” or there is a critical impact to your business operations. You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your business operations are negatively affected by inadequate performance of Cisco products. You and Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired while most business operations remain functional. You and Cisco will commit resources during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online and printed sources.

- The Cisco Online Subscription Center is the website where you can sign up for a variety of Cisco e-mail newsletters and other communications. Create a profile and then select the subscriptions that you would like to receive. To visit the Cisco Online Subscription Center, go to this URL:

  http://www.cisco.com/offer/subscribe
The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief product overviews, key features, sample part numbers, and abbreviated technical specifications for many Cisco products that are sold through channel partners. It is updated twice a year and includes the latest Cisco channel product offerings. To order and find out more about the Cisco Product Quick Reference Guide, go to this URL:
http://www.cisco.com/go/guide

Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo merchandise. Visit Cisco Marketplace, the company store, at this URL:
http://www.cisco.com/go/marketplace/

Cisco Press publishes a wide range of general networking, training, and certification titles. Both new and experienced users will benefit from these publications. For current Cisco Press titles and other information, go to Cisco Press at this URL:
http://www.ciscopress.com

Internet Protocol Journal is a quarterly journal published by Cisco for engineering professionals involved in designing, developing, and operating public and private internets and intranets. You can access the Internet Protocol Journal at this URL:
http://www.cisco.com/ipj

Networking products offered by Cisco, as well as customer support services, can be obtained at this URL:

Networking Professionals Connection is an interactive website where networking professionals share questions, suggestions, and information about networking products and technologies with Cisco experts and other networking professionals. Join a discussion at this URL:
http://www.cisco.com/discuss/networking

“What’s New in Cisco Documentation” is an online publication that provides information about the latest documentation releases for Cisco products. Updated monthly, this online publication is organized by product category to direct you quickly to the documentation for your products. You can view the latest release of “What’s New in Cisco Documentation” at this URL:
http://www.cisco.com/univercd/cc/td/doc/abtunicd/136957.htm

World-class networking training is available from Cisco. You can view current offerings at this URL:
Obtaining Additional Publications and Information
Introducing the Cisco ANA Soft Properties Manager

This chapter describes the Cisco ANA Soft Properties Manager. In addition, it provides a brief explanation of the terms soft properties and alarm thresholds used throughout this guide.

- **About the Soft Properties Manager, page 1-1**—Describes the Cisco Active Network Abstraction (ANA) platform and architecture. In addition, it provides a brief description of the Soft Properties Manager.
- **Soft Properties, page 1-2**—Provides a description of soft properties.
- **Alarm Thresholds, page 1-2**—Provides a description of alarm thresholds.
- **Basic Concepts and Terms, page 1-2**—Provides a brief description of some basic concepts and terms.

**Note**

Changes to the registry should only be carried out with the support of Cisco Professional Services.

**About the Soft Properties Manager**

Cisco ANA provides deep auto-discovery and maintains a live model of the network. This model is based on Cisco’s Device Component Modeling (DCM) architecture, in which each Network Element (NE) is modeled as an interconnected hierarchy of Device Components (DCs), both physical (for example, cards, ports) and logical (for example, forwarding tables, profiles). Each DC maintains a set of properties, which contain its actual data (status, configuration, performance and so on).

When interacting with Northbound clients, the DCM information is translated internally into Information Model Objects (IMO), this is Cisco’s TMF513-based Northbound information model, which is the public language of the Cisco ANA system with external systems.

The Cisco ANA property management framework enables the user to extend (in runtime) the system’s coverage and capabilities in two areas, namely:

- **Soft Properties**—Extending the NE data collection and modeling, by adding new properties to the DCs, and assigning them to NE MIB variables. The new soft properties are also automatically added to the Northbound IMO.
- **Alarm Thresholds**—Assigning various types of alarm conditions to soft properties.

All property definitions and parameters are maintained in XML meta-data in the registry. To ease the definition process, Cisco ANA provides a friendly, simple-to-use GUI that guides the user through the definition and testing process, and hides the underlying XML definitions.
Soft Properties

Cisco ANA Virtual Network Elements (VNEs) by default model a subset of the device properties, which cover the most important and commonly used properties. Cisco ANA offers the *Soft Properties* mechanism to enable user-configurable extension of device modeling, which can cover any unsupported MIB variable. This enables adding new monitored NE properties in runtime to the default set of supported properties.

The Soft Properties mechanism enables quick adaptation to new software upgrades and new requirements that arise during ongoing operation and deployment. It provides the field engineer with the ability to adapt the currently installed Cisco ANA software to changes in the deployed network.

Every Soft Property is implemented through a set of definitions that determine how to retrieve, parse and display a certain MIB variable from the NE. The definition process is done through a simple GUI utility, and does not require system restart. Soft properties are retrieved from the NE using SNMP, or Telnet/SSH.

For example, consider the case where the Cisco ANA system monitors the port parameters of an ATM switch, and the operator installs a new software version on the switch that is capable of reporting the BER for each of the ports. Since this capability was not supported in previous software versions of the NE, the Cisco ANA VNE might not support the property. To avoid the need for a new VNE from Cisco, the Soft Property mechanism enables the user to immediately support the new BER feature in the currently installed version.

Alarm Thresholds

Cisco ANA’s main positioning is as a mediation layer between the network and the operational and business support systems. As such, it abstracts the physical network and provides a generic, vendor-neutral network model, with a consistent information model and interface.

Cisco ANA also provides the user with the ability to leverage its live network model for intelligent data processing within the mediation layer. This enables Cisco ANA to conduct advanced processing in areas like fault correlation, root-cause analysis, impact analysis, activation design/validation and so forth. This intelligence enables Cisco ANA to provide processed information to the applications in the upper tiers. This enables Cisco ANA to enhance application functionality, while dramatically reducing the application’s complexity and the uploaded data volumes.

Alarm thresholding is one of the major areas in which Cisco ANA can boost its Northbound clients. With this mechanism, Cisco ANA constantly monitors selected properties and generates an alarm every time they cross a user-defined threshold or violate a condition. This eliminates the need for OSS/BSS applications to constantly upload huge amounts of data and process it. Instead, Cisco ANA filters-out irrelevant data, and sends only meaningful notifications.

Basic Concepts and Terms

Managed Element—Anything managed by the system, usually a component managed by the VNE, for example, a device.

Network Element (NE)—A user-named physical component or device existing in the network.
Virtual Network Element (VNE)—A virtual representation of a single network element as a modeled component. VNEs all communicate with each other to present ANA-based applications with a single, common device abstraction for network element discovery, configuration, status collection, fault analysis and other basic network (FCAPS) functions. VNEs can be extended to support new application functionality.
Getting Started

This chapter describes the Soft Properties Manager’s working environment and how to access the Soft Properties Manager’s tools. In addition, it describes from creating to publishing a soft property:

- **Opening the Soft Properties Manager, page 2-2**—Describes how to open the Soft Properties Manager.
- **Soft Properties Manager Window, page 2-3**—Describes the Soft Properties Manager, including, the toolbar and menu options.
- **Soft Properties Manager Workflow, page 2-6**—Describes the steps required to create a new soft property.
- **Creating or Editing a Soft Property, page 2-8**—Describes how to start creating a soft property. In addition, it describes how to edit a soft property.
- **Defining the General Parameters, page 2-9**—Describes how to define the general parameters of a soft property, including, a soft property table.
- **Defining the Parsing Parameters, page 2-10**—Describes how to define the parsing parameters of a soft property
- **Testing the Parsing Rules, page 2-15**—Describes how to test the parsing rules.
- **Defining the TCA Alarms Parameters, page 2-16**—Describes how to define the TCA alarms parameters of a soft property
- **Debugging the Soft Property, page 2-18**—Describes how to debug the soft property.
- **Viewing the Soft Property in the Inventory Window, page 2-19**—Describes how to view the newly created or edited soft property in the Inventory window.
- **Publishing the Soft Property, page 2-19**—Describes how to publish a soft property to one or more locations across the inheritance hierarchy.
- **Deleting a Soft Property, page 2-22**—Describes how to delete a soft property.
- **Importing and Exporting a Soft Property, page 2-22**—Describes how to export and import soft properties between managed elements.
- **Closing the Soft Properties Manager, page 2-23**—Describes how to close the Soft Properties Manager.
Opening the Soft Properties Manager

This section provides instructions for launching the Soft Properties Manager. The Soft Properties Manager is launched from a specific network element, which could be a managed element or a selected object within a managed element, such as a port. This network element will be used to develop and test the soft property. The content displayed in the Soft Properties Manager window is based on the location from which it is launched.

Once the soft property has been completed it can be published and attached to a wider scope of managed elements.

**Note**
Initially the soft property only applies to the specific object that you are working on during runtime. Once the soft property has been published and the system has been restarted it will be applied to all objects all objects of the same type, according to the location to which it is published.

To open the Soft Properties Manager:

**Step 1**
Right-click on a managed element in the NetworkVision window’s tree pane or workspace to display a shortcut menu.

**Note**
For more information about the NetworkVision window see the *Cisco Active Network Abstraction NetworkVision User Guide*.

or

Open the Inventory window for the required managed element and right-click on the required object in the network element, for example, port or card.

**Note**
For more information about the Inventory window see the *Cisco Active Network Abstraction NetworkVision User Guide*.

**Step 2**
Select **Management | Soft Properties Management** from the shortcut menu. The Soft Properties Manager window is displayed.
Soft Properties Manager Window

An example of the Soft Properties Manager window is displayed.

*Figure 2-1 Soft Properties Manager Window*

1. Menu bar
2. Toolbar
3. Properties panel
4. Element properties table

The Soft Properties Manager window displays a table of all the existing soft properties according to the selected entity from which it has been launched. In addition, the applicable properties panels for the managed entity from which the Soft Properties Manager was launched are displayed. For example, for an ATM port the properties panels displayed are Location Information, ATM, and DS3.

**Note**

No soft properties will be displayed in the Soft Properties Manager window for a managed element and/or required object in the network element when it is opened for the first time.

The Soft Properties Manager enables the user to:

- Add a new soft property.
- Edit an existing soft property.
- Delete a soft property.
• Import and/or export soft properties.
• Test a soft property on the selected managed element.
• Publish a soft property and attach it to a wider scope of managed elements.

The Soft Properties Manager consists of the following:

- Properties Panel, page 2-4
- Element Properties Table, page 2-4 for the selected managed element or network element
- Soft Properties File Menu, page 2-5
- Soft Properties Tools Menu, page 2-5

**Properties Panel**

The properties panel is a dropdown list that contains a list of panels equivalent to the panels displayed in NetworkVision for the selected network element from which the Soft Properties Manager was launched. For example, where an ATM port is selected as the launching point the properties panel contains Location Information, ATM and OC3 properties. The user can then select the panel to which to add the property.

**Element Properties Table**

The content displayed in the element properties table changes according to the selection made in the properties panel. The following information is displayed in the element properties table of the Soft Properties Manager window:

- **Label**—The name of the property as displayed in the GUI, for example, Port Type. For tables this is the table name displayed in the tab.
- **Type**—The soft property type, namely, Property or Table.
- **Polling**—The polling group specified for the property, for example, system or status.
- **Enabled**—Runs (true) or does not run (false) the command.
- **Command Line**—The command execution for this protocol that should be sent to the NE to retrieve the property. This command can be either a Telnet/SSH command or an SNMP get for a specific OID.

A table can be sorted:

- According to a column by clicking on the required column heading. The sort icon is displayed next to the selected column heading.
- In ascending or descending order by clicking on the column heading. A triangle is displayed next to the selected column heading.

Clicking on a red triangle displayed in a cell expands the cell to display all the information in the cell.

The Location field displays the number of selected rows and the total number of rows in the table, for example, 2/16 Selected. In addition, it displays the location of the selected row(s) in the table, for example, Line 3.
Soft Properties Manager Menu Bar

This section provides a description of each option available in the Soft Properties Manager menus. The following menus are available:

- The File menu
- The Tools menu

Soft Properties File Menu

The File menu is displayed and provides the following options:

- **New Element**—Enables the user to create a new soft property. For more information see Creating or Editing a Soft Property, page 2-8.
- **Edit Element**—Enables the user to edit an existing soft property. For more information see Editing a Soft Property, page 2-8.
- **Delete Element**—Enables the user to delete a soft property whether or not it has been published. For more information see Deleting a Soft Property, page 2-22.

Soft Properties Tools Menu

The Tools menu is displayed.

The Tools menu provides the following options:

- **Export Element**—Enables the user to save a soft property to a file that can later be imported to another managed element. For more information see Importing and Exporting a Soft Property, page 2-22.
- **Import Element**—Enables the user to copy a soft property from an exported file and import this soft property to another managed element. For more information see Importing and Exporting a Soft Property, page 2-22.
- **Hierarchy Manager**—Enables the user to move the soft property to a different location or change the scope of the soft property across the network hierarchy (publishing). For more information see Publishing the Soft Property, page 2-19.

Soft Properties Toolbar

The following buttons are displayed in the Soft Properties Manager:

<table>
<thead>
<tr>
<th>Table 2-1</th>
<th>Soft Properties Manager Toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>![New Element]</td>
<td>New Element—Enables the user to create a new soft property. For more information see Creating or Editing a Soft Property, page 2-8.</td>
</tr>
<tr>
<td>![Edit Element]</td>
<td>Edit Element—Enables the user to edit an existing soft property. For more information see Editing a Soft Property, page 2-8.</td>
</tr>
<tr>
<td>![Delete Element]</td>
<td>Delete Element—Enables the user to delete a soft property whether or not it has been published. For more information see Deleting a Soft Property, page 2-22.</td>
</tr>
</tbody>
</table>
Table 2-1  Soft Properties Manager Toolbar (continued)

- **Export Element**—Enables the user to save a soft property to a file that can later be imported to another managed element. For more information see Importing and Exporting a Soft Property, page 2-22.

- **Import Element**—Enables the user to copy a soft property from an exported file and import this soft property to another managed element. For more information see Importing and Exporting a Soft Property, page 2-22.

- **Hierarchy Manager**—Enables the user to move the soft property to a different location or change the scope of the soft property across the network hierarchy. For more information see Publishing the Soft Property, page 2-19.

The Close button closes the Soft Properties Manager window. For more information see Closing the Soft Properties Manager, page 2-23.

Soft Properties Manager Workflow

The workflow below describes the steps required to define a new soft property definition using the Soft Properties Manager and the order in which they must be performed.
At any point after the soft property has been defined, it can be tested, and published to a wider scope of managed elements and/or network elements.

For more information:

- Creating or Editing a Soft Property, page 2-8
- Defining the General Parameters, page 2-9
- Defining the Parsing Parameters, page 2-10
- Testing the Parsing Rules, page 2-15
- Defining the TCA Alarms Parameters, page 2-16
- Debugging the Soft Property, page 2-18
- Viewing the Soft Property in the Inventory Window, page 2-19
- Publishing the Soft Property, page 2-19
- Deleting a Soft Property, page 2-22
- Importing and Exporting a Soft Property, page 2-22
Creating or Editing a Soft Property

The Soft Properties Manager enables the user to create or edit an existing soft property using the Add Soft Property dialog box. First the user must determine the managed element and/or selected object in the network element to which the soft property should be added.

To create a Soft Property

---

**Step 1**
Right-click on a managed element in the NetworkVision window’s tree pane or workspace to display a shortcut menu,

or

Open the Inventory window for the required managed element and right-click on the required object in the network element, for example, port or card. A shortcut menu is displayed.

**Step 2**
Select **Management | Soft Properties Management** from the shortcut menu. The Soft Properties Manager window is displayed.

**Step 3**
Click **New Element** on the toolbar of the Soft Properties Manager window.

or

Select **New Element** from the File menu or shortcut menu. The Add Soft Property dialog box is displayed.

The Add Soft Property dialog box is divided into the following tabs (configuration categories):

- **General** tab enables you to configure general definitions for the soft property. For more information about defining the General parameters see Defining the General Parameters, page 2-9.
- **Parsing** tab enables you to configure parsing definitions for the soft property. For more information about defining the Parsing parameters see Defining the Parsing Parameters, page 2-10.
- **TCA Alarms** tab enables you to configure alarm threshold management for the soft property. For more information about defining the TCA Alarms parameters see Defining the TCA Alarms Parameters, page 2-16.

Editing a Soft Property

The user can edit an existing soft property and the soft property that is edited will affect only the local instance. When an inherited soft property is edited, the new local instance overrides the generic soft property definition for the specific managed element.

To edit a soft property:

---

**Step 1**
Select the soft property that you want to edit in the table of the Soft Properties Manager window.

**Step 2**
Click **Edit Element** on the toolbar of the Soft Properties Manager window.

or

Select **Edit Element** from the File menu or shortcut menu.

The hierarchy manager table is displayed.
Defining the General Parameters

The **General** tab enables the user to configure general definitions for the soft property. The user can also configure just a single soft property field or an entire soft property table.

To define the General parameters:

**Step 1** Select the **General** tab in the Add Soft Property dialog box. The **General** tab is displayed.

The following fields are displayed in the **General** tab of the Add Soft Property dialog box:

- **Name**—The soft property identifier, which is unique to the location and IMO scope. This field is mandatory.

  **Note** A warning message is displayed if the name specified already exists. The user will be asked whether to override the existing soft property implementation.

- **Label**—The soft property name that is displayed in the GUI, which is unique to the location and IMO scope. For tables this is the table name that is displayed in the tab. This field is mandatory.

- **Description**—A description of the soft property.

The following dropdown lists are displayed in the **General** tab of the Add Soft Property dialog box:

- **Type**—The soft property type, namely, **Property** or **Table**. By default **Property** is selected. The fields displayed in the **Parsing** tab are dependent on the user’s selection.

  **Note** If **Table** is selected the TCA Alarms tab is not displayed in the Add Soft Property dialog box.
Defining the Parsing Parameters

The Parsing tab enables the user to configure, view and edit parsing definitions defined for the soft property.

To define the Parsing parameters:

Step 1
Select the Parsing tab in the Add Soft Property dialog box. The Parsing tab is displayed as shown below when the Property type is selected in the General tab.
Note

If the Table type is selected in the General tab only the SNMP option is displayed. For more information about defining parsing parameters for a soft property table see Defining the Parsing Parameters of a Soft Property Table, page 2-14.

The Parsing tab enables you to specify either a Telnet/SSH command or a MIB OID for an SNMP GET command.

The following radio buttons are displayed in the Parsing tab:

- **Use SNMP get(OID)**—The SNMP retrieval expression. The text field is enabled and mandatory when this option is selected. The expression can include environmental arguments.

  **Note** When Use SNMP get(OID) is selected press Ctrl-Spacebar in the text box to open a selection list of the entire collection of parameters available for all the protocols.

  An example of the output presented when pressing Ctrl-Spacebar for a port is displayed below.

  **Figure 2-3 Output**

  ![Output](image)

  Sometimes, when building a soft property the Telnet/SNMP command is context sensitive. A good example of this is when you want to retrieve some port related data through SNMP, "walking" all the ports to find the relevant port each time is not efficient and can greatly affect system performance. To solve this "Instrumentation Data" is available for the soft property. The instrumentation data is a variant between different elements in the system depending on the context object to which you want to add the soft property to.

  In this example, the instrumentation data is the port ifIndex. In order to use the ifIndex in the OID, do the following "1.3.1.6......$ifIndex$.5.6.4". In order to ascertain what instrumentation data is available for your context object press Ctrl-Spacebar while the cursor is on the "command" field.

- **Use Telnet/SSH**—The Telnet/SSH retrieval expression. The text field is enabled and mandatory when this option is selected. The expression can include environmental arguments.

  **Note** When Use Telnet/SSH is selected press Ctrl-Spacebar in the text box to open a selection list of the entire collection of parameters available for all the protocols.

  The text area in the Parsing tab enables you to enter the command line of the protocol. For example, for SNMP enter the OID of the SNMP packet; and for Telnet enter the Telnet command line.

  **Note** The SNMP OID should start with a dot, for example, if the user wants to retrieve the OID value of “1.3.6.....” then the user should write “.1.3.6.....”.
The following columns are displayed in the table of the Parsing tab:

- **Index**—Displays the order of the parsing rules.
- **Operation**—Displays the parsing operator type selected in the Add/Edit Parsing Rule dialog box. For more information about parsing operators see Appendix A, “Parsing Operators/Rules”.

The following buttons are displayed in the Parsing tab:

- **Add**—Enables you to add a new operator. The Add/Edit Parsing Rule dialog box is displayed.
- **Edit**—Enables you to edit an existing operator. The Add/Edit Parsing Rule dialog box is displayed.

  > **Note** You can also edit an operator by double-clicking on the required operator in the table.

- **Delete**—Enables you to delete the selected operator from the table.

  > **Note** Delete an operator by selecting it in the table and clicking Delete.

- **Test**—Enables you to test the soft property parsing. The Test Parsing Rules dialog box is displayed. For more information see Testing the Parsing Rules, page 2-15.

  The reorder arrows enable you to move the rules up and down within the sequence in order to change the parsing order.

**Step 2** Select one of the following options:

- Use SNMP get(OID) or
- Use Telnet/SSH or

**Step 3** Click **Add**. The Add/Edit Parsing Rule dialog box is displayed.

---

**Figure 2-4 Add/Edit Parsing Rule Dialog Box**

---
The Add/Edit Parsing Rule dialog box is used for adding, editing and testing of the parsing operators. Once the required operator is selected, the corresponding arguments are displayed.

The following dropdown lists are displayed in the Add/Edit Parsing Rule dialog box:

- **Input Buffer**—A dropdown list that displays the list of output arguments defined in previous operators and the default (the standard output buffer of the last predecessor operator that was not redirected into an output argument). This field is mandatory.

  The parsing result of operator N is available by default as input for operator N+1 (appear as Default for the Input Buffer). The parsing result of operator N may be directed to a locally defined environment argument. In this case the input for operator N+1 is the same as for operator N. Changing the default input buffer is supported by selecting an input buffer other than Default. The available inputs buffers for Operator N+1 are the set of output arguments defined in Operators 1 through N.

  The fields displayed in the Expression area of the window change depending on your selection in the Operator dropdown list, which is mandatory. When an operator is selected the corresponding arguments are displayed. The Operator dropdown list enables you to select one of the available parsing operators, namely:

- **Header And Footer**—Removes a specified number of lines from the header and footer of the input text. For more information see Header and Footer, page A-1.

- **Remove Lines**—Removes a range of lines from the specified starting row to the specified end row of the input text. For more information see Remove Lines, page A-2.

- **Select Lines**—Extracts a range of lines from the specified starting row to the specified end row of the input text. For more information see Select Lines, page A-3.

- **Replace**—Finds one or all occurrences of a substring, which matches a specified regular expression, and replaces it with a specified value. For more information see Replace, page A-4.

- **Match**—Finds and extracts a substring, which matches a specified regular expression. If no match can be found the output buffer receives an empty string. For more information see Match, page A-6.

- **Set**—Formats the input buffer and local arguments defined in previous operators using a regular expression. For more information see Set, page A-7.

- **Substring**—Extracts a substring of a specified length from a specified starting point. For more information see Substring, page A-8.

- **Parse Integer**—Uses the substring rule and when a result is received with the substring it converts it into an integer value. For more information see Parse Integer, page A-9.

**Note**

If the substring operator contains any characters the parsing integer operator will fail.

The **Argument 1** and **Argument n** fields displayed in the Add/Edit Parsing Rule dialog box is dynamic and lists the corresponding arguments according to the selected operator. For more information about the operators and the corresponding arguments that are displayed see Appendix A, “Parsing Operators/Rules”.

<table>
<thead>
<tr>
<th></th>
<th>Argument 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Argument n</td>
</tr>
<tr>
<td>3</td>
<td>Source</td>
</tr>
<tr>
<td>4</td>
<td>Result</td>
</tr>
</tbody>
</table>

---

1-13
Defining the Parsing Parameters

The Direct result to output buffer variable checkbox and corresponding field enables you to direct the parsing output to the provided argument instead of it being the input value for the next operator. The text box is only enabled when the checkbox is selected and a unique (within the complete parsing sequence of this soft property instance) argument name must be provided in this field.

The Simulation area is divided into two text areas:

- The Source text box is used to enter or paste parsing information.
- The Result text box is used to view the parsed result.

The information entered and displayed in the Simulation area is not saved when the dialog box is closed. The Test Expression button parses the information entered in the Source text box according to the parsing operator defined and displays the result in the Result text box.

The following buttons are displayed in the Add/Edit Parsing Rule dialog box:

- OK—Validates the operator according to the selected operator’s validation rules. Saves the changes and closes the Add/Edit Parsing Rule dialog box.
- Cancel—Closes the Add/Edit Parsing Rule dialog box without saving the changes.

Step 4

Define the parsing rules.

Proceed to Testing the Parsing Rules, page 2-15 to test the parsing rules.

Defining the Parsing Parameters of a Soft Property Table

The Parsing tab displayed in the Add Soft Property dialog box changes when the user selects Table type in the General tab in order to configure a soft property table.

To define the Parsing parameters of a soft property table:

Step 1

Select the Parsing tab in the Add Soft Property dialog box. The Parsing tab is displayed.

The following radio button is displayed in the Parsing tab of the Add Soft Property dialog box:

- Use SNMP get(OID)—The SNMP retrieval expression. The text field is mandatory when this option is selected. The expression can include environmental arguments.

Note When Use SNMP get(OID) is selected press Ctrl-Spacebar in the text box to open a selection list of the entire collection of parameters available for all the protocols.

The following columns are displayed in the table of the Parsing tab:

- Title—Displays the column headings of the table.
- OID—Displays the column information for the table.

For more information about the buttons displayed in this tab see Defining the Parsing Parameters, page 2-10.

Step 2

Click Add. The Add/Edit Column Controller dialog box is displayed.

The Add/Edit Column Controller dialog box enables you to add, and/or edit the columns and information displayed in the table.
Chapter 2      Getting Started

Testing the Parsing Rules

The Soft Properties Manager provides testing functions, which enable the user to simulate each parsing rule (as well as the whole parsing sequence). In addition, the user can test and debug the property on the NE.

The user can test and simulate the actual input parsing according to the parsing operators and display the parsing result. This tests all the defined parsing rules in the order that they are given.

To test the parsing rules:

Step 1 Click Test Expression in the Add/Edit Parsing Rule dialog box. The Test Parsing Rules dialog box is displayed.

The Input Buffer area enables the user to enter the input to parse. The parsing input can be copied and pasted by the user or be retrieved from the device. The Input Buffer area is mandatory.

The Output Buffer area displays the parsing result log. It may contain only the final parsing result or the entire parsing log with comments per parser used.

The following buttons are displayed in the Test Parsing Rules dialog box:

- Close—Closes the Test Parsing Rules dialog box.
- Test— Parses the input entered in the Input Buffer area according to the parsing operators. The parsing result is displayed in the Output Buffer area.

Step 2 Click Test. The results of the test are displayed Test Parsing Rules dialog box.

Step 3 Click Close. The Add/Edit Parsing Rule dialog box is displayed.

Step 4 Click OK. The Parsing tab is displayed.

Proceed to Defining the TCA Alarms Parameters, page 2-16 to define the TCA alarm parameters of the soft property.
Defining the TCA Alarms Parameters

The TCA Alarms tab enables the user to set threshold conditions for the soft property value, which will generate an alarm when crossed.

The user can select the severity level that will be associated with the alarm, and enable/disable the alarm. In addition, the user can select the threshold type.

The user can define multiple alarms for the same soft property. The alarm is displayed in the ticket pane of the NetworkVision window.

To define the TCA Alarms parameters:

**Step 1** Select the TCA Alarms tab. The TCA Alarms tab is displayed.

| Note | The TCA Alarms tab is only displayed when the Property type is selected in the General tab. |

The following columns are displayed in the TCA Alarms tab:
- Description—A free text area used to describe the alarm.
- Trigger—Displays the details of the trigger selected, namely, what will cause the alarm to be sent. For more information about triggers see Appendix B, “Alarm Threshold Triggers”.
- Enabled—Displays the status of the alarm, namely, enabled (true) or disabled (false), as defined in the General tab of the Add TCA dialog box.

The following buttons are displayed in the TCA Alarms tab:
- Add—Opens the Add TCA dialog box, enabling you to define the parameters of the TCA alarm.
- Edit—Opens the Add TCA dialog box enabling you to edit the parameters of a previously defined TCA alarm.

| Note | Edit the parameters of a TCA alarm by selecting it in the table and clicking Edit. |

- Delete—Deletes the selected TCA alarm from the TCA Alarms tab.

| Note | Delete a TCA alarm by selecting it in the table and clicking Delete. |

**Step 2** Click Add. The Add TCA dialog box is displayed. The Add TCA dialog box is divided into the following tabs:

- General tab—Enables you to define the general parameters of the TCA alarm, for example, the severity and the name of the alarm.
- Trigger tab—Enables you to define the alarm threshold trigger for the TCA alarm. For more information see Appendix B, “Alarm Threshold Triggers”.

The following fields are displayed in the General tab of the Add TCA dialog box:
- Name—The alarm name that is displayed in the ticket pane when the alarm is triggered.
- Description—A description of the alarm.
The following checkboxes are displayed in the **General** tab of the Add TCA dialog box:

- **Enabled**—Select this option to enable the alarm or deselect this option to disable the alarm.
- **Can be correlated to other alarms**—Select this option to correlate this alarm to other alarms. For more information about correlating alarms see the *Cisco Active Network Abstraction NetworkVision User Guide*.
- **Can other alarms be correlated to this alarm**—Select this option to enable other alarms to be correlated to this alarm. For more information about correlating alarms see the *Cisco Active Network Abstraction NetworkVision User Guide*.

The following dropdown list is displayed in the **General** tab of the Add TCA dialog box:

- **Alarm Severity**—Select the severity level associated with the alarm, namely:
  - Critical
  - Major
  - Minor
  - Warning
  - Normal

  For more information about alarm severity see the *Cisco Active Network Abstraction NetworkVision User Guide*.

The **Alarm description preview** area is currently unavailable in this version.

The following buttons are displayed in the **General** tab of the Add TCA dialog box:

- **OK**—Saves the parameters of the TCA alarm and closes the Add TCA dialog box.
- **Cancel**—Closes the Add TCA dialog box without saving any changes.
- **Apply**—Saves the parameters of the TCA alarm and the Add TCA dialog box remains open.

**Step 3** Define the **General** parameters for the TCA alarm.

**Step 4** Select the **Trigger** tab. The **Trigger** tab in the Add TCA dialog box is displayed. The following dropdown list is displayed in the **Trigger** tab of the Add TCA dialog box:

- **Trigger**—Select one of the following threshold types:
  - **Value Equal**—The alarm condition is reached when the soft property value is equal to the value defined in the “Alarm Value” regardless if it is numeric or not. For more information see **Value Equal**, page B-1.
  - **Value Not Equal**—The alarm condition is reached when the soft property value is NOT equal to the value defined in the “Alarm Value” regardless if it is numeric or not. For more information see **Value Not Equal**, page B-2.
  - **Upper Threshold**—The upper threshold value, which when crossed triggers the alarm for the defined numeric properties. For more information see **Upper Threshold**, page B-2.
  - **Lower Threshold**—The lower threshold value, which when crossed triggers the alarm for the defined numeric properties. For more information see **Lower Threshold**, page B-3.
  - **Upper Rate**—The upper rate threshold value for the performance counters, which when crossed triggers the alarm for the defined numeric properties. For more information see **Upper Rate**, page B-4.
  - **Lower Rate**—The lower rate threshold value for the performance counters, which when crossed triggers the alarm for the defined numeric properties. For more information see **Lower Rate**, page B-5.
For more information about triggers see Appendix B, “Alarm Threshold Triggers”.

**Step 5** Define the Trigger parameters for the TCA alarm.

**Step 6** Click OK. The TCA Alarms tab is displayed.

Proceed to **Debugging the Soft Property**, page 2-18 to debug the soft property.

### Debugging the Soft Property

The user can debug the soft property on the managed element or selected object in the network element by opening the Debug Soft Property dialog box, which displays the status of the soft property when it is debugged. For example, to confirm that a selected device supports Telnet (see Chapter 3, “Examples” for more information).

To debug the soft property:

**Step 1** Click **Debug** in the Add Soft Property dialog box. The Debug Soft Property dialog box is displayed with the results of the debug.

**Figure 2-5 Debug Soft Property Dialog Box**

![Debug Soft Property Dialog Box](image)

**Step 2** Click **Close**. The Add Soft Property dialog box.

**Step 3** Click **OK**. The Soft Properties Manager window is displayed with the newly created soft property displayed in the **element properties** table.

**Step 4** Click **Close**. The NetworkVision or Inventory window is displayed depending on your original selection.

Proceed to **Viewing the Soft Property in the Inventory Window**, page 2-19 to view the results of the soft property in the Inventory window.
Viewing the Soft Property in the Inventory Window

After creating or editing a soft property the user can view the results in the Properties pane of the Inventory window for the managed element or selected object in the network element.

**Note**
The user will only be able to view the soft property in the Inventory window after it has been closed and reopened. For example, if you open an inventory on a VNE and add a property to one of the ports then it will only be displayed after you close and reopen the inventory on the VNE.

To view the soft property:

**Step 1** Right-click on the required managed element in the tree pane or workspace of the NetworkVision window, and select Inventory from the shortcut menu. The Inventory window for the required managed element is displayed with the newly defined soft property or soft property table.

**Step 2** Click in the top right corner to close the Inventory window.

Proceed to Publishing the Soft Property, page 2-19 to publish the soft property.

Publishing the Soft Property

A property definition is applicable to all objects of the same type in the selected NE. However, the user may want to apply the same property definitions to all NEs of the same type or family. This requires moving the property definition from the specific NE instance to a higher level in the registry hierarchy.

After the soft property has been defined and tested on a specific instance of a managed element it can be published and applied to wider scope of managed elements in the network.

The Soft Properties Manager Soft Properties Publish Controller dialog box enables the user to publish the soft property to one or more locations across the inheritance hierarchy (as defined in the system). In other words the user defines the scope where the soft property will be applied in the hierarchy.

Different variations of a soft property can be used for different managed elements and network elements, where the implementation of the soft property is different for each managed element or network element.

An example of an inheritance hierarchy is displayed below. In this example, the top level of the hierarchy is All devices and the lowest level of the hierarchy is Device XYZ.
When a soft property is published to a node in the hierarchy, this overrides any inherited soft properties from a higher level, and automatically applies it to all its children. For example, if a soft property is published to Cisco 7200 it will override any variant of this soft property which is defined at a higher level, and will be assigned to all devices of type Cisco 7200 in the system.

**Note**

It is highly recommended that you measure the affect of publishing the soft property on memory usage of the system before it is published. To view the changes you must restart the VNE or unit in order for the publishing to take affect. For more information about measuring the affect of publishing the soft property, please contact Cisco Professional Services.

**Note**

Soft property publishing sometimes deeply affects the system memory usage, device utilization and system performance. For example, the user can add a property running "show running-config" to the device in status polling and publish it to a group of devices. This will probably cause the system memory usage to jump and the device’s utilizations to jump.

To publish a soft property:

**Step 1**

Right-click on the required managed element in the tree pane or workspace of the NetworkVision window.

or

Open the Inventory window for the required managed element and right-click on the required object in the network element.

**Step 2**

Select Management | Soft Properties Management from the shortcut menu. The Soft Properties Manager window is displayed.

**Step 3**

Select the required properties panel and soft property in the element properties table.

**Step 4**

Click Hierarchy Manager on the toolbar of the Soft Properties Manager window.

or

Select Hierarchy Manager from the Tools menu or shortcut menu.

The hierarchy manager table is generated and displayed.
Note

If user-friendly VNE names exist in the schema then the hierarchy manager table will display these user-friendly registry location names in the VNE Hierarchy Location column. A user-friendly VNE name is a hierarchy path that has been defined in the registry and is then displayed in the hierarchy manager table. For more information see Publishing the Soft Property, page 2-19.

Each row that is displayed in the hierarchy manager table represents a different level of the hierarchy. The rows are displayed in descending order; the top row is the highest level of the hierarchy and the bottom row is the lowest level of the hierarchy.

The following information is displayed in the table:

- **Exist**—When a node in the hierarchy is selected this indicates that a local variant of the soft property exists for that node.
- **VNE Hierarchy Location**—The hierarchy path, as defined in the registry.
- **IMO Class Name**—Currently unavailable in this version.

The following tools are displayed in the Hierarchy Manager window:

**Table 2-2 Hierarchy Manager window tools**

- Copies the soft property from a selected node in the hierarchy in order to copy it to another node in the hierarchy. A copy icon is displayed to the left of the selected node.
- Cuts the soft property from a selected node in the hierarchy in order to move it to another node in the hierarchy. A cut icon is displayed to the left of the selected node.
- Pastes the soft property that was copied or cut from a selected node in the hierarchy to another node in the hierarchy. A paste icon is displayed to the left of the selected node.
- Deletes the soft property from the selected node in the hierarchy.

Note

If the soft property has been deleted from all the nodes, the soft property will be removed from the list in the main dialog of the Soft Properties Manager.

The following button is displayed in the Hierarchy Manager window:

- **Close**—Closes the Hierarchy Manager window without publishing the soft property.

**Step 5** Select the required node in the hierarchy from which you want to publish the soft property.

**Step 6** Click **Copy** or **Cut** on the toolbar to copy or cut the soft property.

**Step 7** Select the required node in the hierarchy where you want to publish the soft property.

**Step 8** Click **Paste** on the toolbar to paste the soft property. The soft property is published to the selected node in the hierarchy.
Deleting a Soft Property

Soft properties created by the user are by default always created as a local instance. A soft property that is defined locally is selected in the Soft Properties Publish Controller dialog box. The user can delete soft properties whether or not they have been published.

To delete a soft property:

Step 1 Select the soft property that you want to delete in the element properties table of the Soft Properties Manager dialog box.

Step 2 Click **Delete Element** on the toolbar of the Soft Properties Manager window.

or

Select **Delete Element** from the File menu or shortcut menu.

A warning message is displayed.

Step 3 Click **Yes**. The soft property is deleted and no longer displayed in the element properties table of the Soft Properties Manager window.

Importing and Exporting a Soft Property

The Soft Properties Manager enables the user to export (save) a soft property definition to a file. The soft property definition can then be imported (copied) later to another managed element.

In addition, the user can export and import a soft property definition to a file and publish it to multiple places in the Hierarchy Manager window.

To export a soft property:

Step 1 Select the soft property that you want to export in the **element properties** table of the Soft Properties Manager dialog box.

Step 2 Click **Export Element** on the toolbar of the Soft Properties Manager dialog box.

or

Select **Export Element** from the Tools menu or shortcut menu.

The Export dialog box is displayed.

Note If user-friendly VNE names exist in the schema then the hierarchy manager table will display these user-friendly registry location names in the VNE Hierarchy Location column. A user-friendly VNE name is a hierarchy path that has been defined in the registry and is then displayed in the hierarchy manager table. For more information see **Publishing the Soft Property**, page 2-19.

Step 3 Select the version that you want to export in the table of the Export window. The version is selected in the table.

Step 4 Click **OK**. The Export Property dialog box is displayed.

Step 5 Browse to the directory where you want to save the soft property.
Step 6  In the **File name** field, enter a name and extension (for example, `.txt`) for the soft property.

Step 7  Click **Save**. The soft property is saved in the selected directory. The Export dialog box is displayed.

Step 8  Click **Close**. The Soft Properties Manager window is displayed.

---

To import a soft property:

**Step 1**  Click **Import Element** on the toolbar of the Soft Properties Manager window.

or

Select **Import Element** from the Tools menu.

The Import Element dialog box is displayed.

**Step 2**  Browse to the directory and soft property that you want to import.

**Step 3**  Click **Open**. The Import elements window is displayed.

**Step 4**  Select the version that you want to import in the table of the Import Elements window. The version is selected in the table.

**Step 5**  Click **OK**. The Soft Properties Manager window is displayed.

**Step 6**  Click **Close**. The soft property is imported to the selected managed element or network element and displayed in the Soft Properties Manager window.

---

**Closing the Soft Properties Manager**

When the user has finished working with the Soft Properties Manager the user can close the Soft Properties Manager.

To close the Soft Properties Manager, click **Close**. The Soft Properties Manager is closed.
Examples

This chapter provides several examples of creating a soft property from start to finish, including defining the TCA alarms and defining a soft property table:

- **Basic Soft Property Example, page 3-1**—Describes how to create a simple soft property from beginning to end, including publishing the soft property to another node in the hierarchy.
- **Soft Property Example Including TCA Alarm, page 3-8**—Describes how to define a TCA alarm for a soft property.
- **Soft Property Table Example, page 3-10**—Describes how to define a soft property table.

**Basic Soft Property Example**

This section describes how to create a simple soft property from beginning to end.

To create a soft property (excl. TCA alarm):

**Step 1** Right-click on a managed element in the tree pane or workspace of the NetworkVision window. 
or
Open the Inventory window for the required managed element and right-click on the required object in the network element, for example, port or card.

**Step 2** Select **Management | Soft Properties Management** from the shortcut menu. The Soft Properties Manager window is displayed.

**Step 3** Select the required property from the dropdown list in the **properties panel**.

**Step 4** Click **New Element** on the toolbar of the Soft Properties Manager dialog box. 
or
Select **New Element** from the File menu.

The Add Soft Property dialog box is displayed.

**Step 5** Define the soft property information in the **General** tab as follows:

- **Name**—sp01
- **Label**—My Soft Property
- **Description**—Example of soft property
- **Type**—Property
- **Polling Rate**—Status
- **Enabled**—Selected

**Step 6**  
Select the **Parsing** tab. The **Parsing** tab is displayed.

**Step 7**  
Define the information in the **Parsing** tab as follows:
- Select **Use Telnet/SSH**
- In the text box enter `show ip vrf example`

**Step 8**  
Click **Add**. The Add/Edit Parsing Rule dialog box is displayed.

**Figure 3-1 Add/Edit Parsing Rule Dialog Box**

**Step 9**  
Define the information in the Add/Edit Parsing Rule dialog box as follows:
- **Operator**—Match
- **Expression**—\d\d
- **Source text box**—Enter the information as shown in the example.

**Step 10**  
Click **Test Expression**. The result 55 is displayed in the **Result** text box.

**Step 11**  
Click **OK**. The **Parsing** tab of the Add Soft Property dialog box is displayed.
Step 12  Click Add. The Add/Edit Parsing Rule dialog box is displayed.
Step 13 Define the information in the Add/Edit Parsing Rule dialog box as follows:
- **Operator**—Substring
- **From Index**—1
- **To Index**—1
- **Source text box**—55

Step 14 Click **Test Expression**. The result 5 is displayed in the **Result** text box.

Step 15 Click **OK**. The **Parsing** tab of the Add Soft Property dialog box is displayed.

**Figure 3-4 Parsing Tab**

Click **Test**. The Test Parsing Rules dialog box is displayed enabling you to test all the defined parsing rules in the order given.
Step 17 Click **Test**. The result of the test is displayed in the **Output Buffer** area.

Step 18 Click **Close**. The Add Soft Property dialog box is displayed.

Step 19 Click **Debug**. The Debug Soft Property dialog box is displayed.

- After the Status is returned as valid, check the required input parameters returned the correct values, such as—**Telnet Commands=[show ip vrf example]**
Step 20  Click Close. The Add Soft Property dialog box is displayed.
(To add a TCA Alarm, go to Step 2 in Soft Property Example Including TCA Alarm, page 3-8).

Step 21  Click OK. The Soft Properties Manager window is displayed.

**Figure 3-7  Soft Properties Manager Window**

Step 22  Click Close. The NetworkVision window or Inventory window is displayed depending on your original selection.

Step 23  In order to view the newly created soft property, click in the right top corner to close the Inventory window and then open the Inventory window again.

or

Move up and down a branch in the tree pane of the Inventory window.

The Inventory window for the required managed element is displayed with the newly defined soft property.
Step 24 Right-click on the required managed element in the tree pane or workspace of the NetworkVision window.

or

Right-click on the required object of the network element in the Inventory window.

Step 25 Select Management | Soft Properties Management from the shortcut menu. The Soft Properties Manager window is displayed.

Step 26 Select the required properties panel and soft property in the element properties table.

Step 27 Click Hierarchy Manager on the toolbar of the Soft Properties Manager dialog box.

or

Select Hierarchy Manager from the Tools menu or shortcut menu.

The Hierarchy Manager window is displayed.

Step 28 Select the required node in the hierarchy from which you want to publish the soft property.

Step 29 Click Copy or Cut on the toolbar to copy or cut the soft property.

Step 30 Select the required node in the hierarchy where you want to publish the soft property.

Step 31 Click Paste on the toolbar to paste the soft property. The soft property is published to the selected node in the hierarchy.

Step 32 Click Close. The Soft Properties Manager window is displayed.

For more information about defining a soft property with a TCA alarm see Soft Property Example Including TCA Alarm, page 3-8.
Soft Property Example Including TCA Alarm

This section describes how to define a TCA alarm for a soft property.

To create a soft property including TCA alarm:

**Step 1** Perform steps 1-20, as described in the Basic Soft Property Example, page 3-1.

**Step 2** Select the TCA Alarms tab. The TCA Alarms tab is displayed.

**Step 3** Click Add. The General tab of the Add TCA dialog box is displayed.

**Step 4** Define the information in the TCA Alarms tab as follows:

- **Name**—My value is not 5.
- **Enabled**—Selected.
- **Description**—Show this alarm if the value is not equal to 5.
- **Alarm Severity**—CRITICAL.

**Step 5** Select the Trigger tab in the Add TCA dialog box. The Trigger tab is displayed.

**Step 6** Define the information in the Trigger tab as follows:

- **Trigger**—Value Not Equal.
- **To value**—5

**Step 7** Click OK. The TCA Alarms tab is displayed with the defined TCA alarm.

**Step 8** Click OK. The Soft Properties Manager window is displayed.

**Step 9** Click Close. The NetworkVision window is displayed or Inventory window is displayed depending on your original selection.

**Step 10** In order to view the newly created soft property, click in the right top corner to close the Inventory window and then open the Inventory window again.

or

Move up and down a branch in the tree pane of the Inventory window.

The Inventory window for the required managed element is displayed with the newly defined soft property.
The example below displays the Inventory window before the defined alarm has been triggered.

**Figure 3-9  Inventory Window Before Alarm Triggered**

![Inventory Window Before Alarm Triggered](image)

The example below displays the Inventory window after the alarm has been triggered.

**Figure 3-10  Inventory Window After Alarm Triggered**

![Inventory Window After Alarm Triggered](image)

The example below displays the Inventory window after the alarm has been cleared.
Figure 3-11 Inventory Window After Alarm Cleared

Step 11 Perform steps 24-32, as described in Basic Soft Property Example, page 3-1.

For more information about defining a soft property table see Soft Property Table Example, page 3-10.

Soft Property Table Example

This section describes how to define a soft property table.

To create a soft property table:

Step 1 Perform steps 1-2, as described in the Soft Property Example Including TCA Alarm, page 3-8.

Step 2 Click **New Element** on the toolbar of the Soft Properties Manager window.

or

Select **New Element** from the File menu.

The Add Soft Property dialog box is displayed.

Step 3 Define the soft property information in the **General** tab as follows:

- **Name**—sp02
- **Label**—My Soft Table
- **Description**—Example of a soft table
- **Type**—Table
- **Polling Rate**—Status
- **Enabled**—Selected
Step 4 Select the Parsing tab. The Parsing tab is displayed.

Step 5 Define the information in the Parsing tab by entering .1.3.6.1.2.1.4.20.1 in the text box.

Step 6 Click Add. The Add Edit Column Controller dialog box is displayed.

Step 7 Define the information in the Add Edit Column Controller dialog box as follows:
   - Column Title—My First Column
   - Column Data—2

Step 8 Click OK. The Parsing tab of the Add Soft Property dialog box is displayed with the defined table information for column 1 of the table.

Step 9 Click Add. The Add Edit Column Controller dialog box is displayed.

Step 10 Define the information in the Add Edit Column Controller dialog box as follows:
   - Column Title—My Second Column
   - Column Data—3

Step 11 Click OK. The Parsing tab of the Add Soft Property dialog box is displayed with the defined table information for column 1 and 2 of the table.

Figure 3-12 Add Soft Property Dialog Box

Step 12 Click Debug. The Debug Soft Property dialog box is displayed.

Step 13 Click Close. The Add Soft Property dialog box is displayed.

Step 14 Click OK. The Soft Properties Manager window is displayed.

Step 15 Click Close. The NetworkVision window or Inventory window is displayed depending on your original selection.
Step 16  In order to view the newly created soft property, click in the top right corner to close the Inventory window and then open the Inventory window again.

or

Move up and down a branch in the tree pane of the Inventory window.

The Inventory window for the required managed element is displayed with the newly defined soft property table.

Figure 3-13  Inventory Window

Step 17  Perform steps 24-32, as described in the Basic Soft Property Example, page 3-1.
APPENDIX A  

Parsing Operators/Rules

This chapter describes the pre-defined text manipulation operators available for parsing raw device input and turning it into a soft property that are available in the Add/Edit Parsing Rule dialog box. For each operator its name, description, expected input, validation rules and the unique fields displayed in the dialog box are described. An example of each operator is also provided.

For more information about the Add/Edit Parsing Rule dialog box see Defining the Parsing Parameters, page 2-10.

- Header and Footer, page A-1—Describes the Header And Footer operator and provides an example.
- Remove Lines, page A-2—Describes the Remove Lines operator and provides an example.
- Select Lines, page A-3—Describes the Select Lines operator and provides an example.
- Replace, page A-4—Describes the Replace operator and provides an example.
- Match, page A-6—Describes the Match operator and provides an example.
- Set, page A-7—Describes the Set operator and provides an example.
- Substring, page A-8—Describes the Substring operator and provides an example.
- Parse Integer, page A-9—Describes the Parse Integer operator and provides an example.

Header and Footer

Description

Removes a specified number of lines from the header and footer of the input text.
Dialog Box

The Add/Edit Parsing Rule dialog box is displayed below when the **Header And Footer** operator is selected. In addition, the dialog box displays an example using the **Header And Footer** operator.

**Figure A-1**  **Header and Footer Operator**

![Header and Footer Operator](image)

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header lines</td>
<td>The number of header lines to be removed.</td>
<td>Integers only. Mandatory.</td>
</tr>
<tr>
<td>Footer lines</td>
<td>The number of footer lines to be removed.</td>
<td>Integers only. Mandatory.</td>
</tr>
</tbody>
</table>

Remove Lines

Description

Removes a range of lines from the specified starting row to the specified end row of the input text.
Dialog Box

The Add/Edit Parsing Rule dialog box is displayed below when the **Remove Lines** operator is selected. In addition, the dialog box displays an example using the **Remove Lines** operator.

![Remove Lines Operator](image)

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>From line</td>
<td>Index of first row to begin removal, inclusive.</td>
<td>Integer only. Mandatory.</td>
</tr>
<tr>
<td>To line</td>
<td>Index of last row to be removed, inclusive.</td>
<td>Integer only. Equal to or greater than From line. Mandatory.</td>
</tr>
</tbody>
</table>

**Select Lines**

**Description**

Extracts a range of lines from the specified starting row to the specified end row of the input text.
Dialog Box

The Add/Edit Parsing Rule dialog box is displayed below when the Select Lines operator is selected. In addition, the dialog box displays an example using the Select Lines operator.

**Figure A-3 Select Lines Operator**

![Select Lines Operator Diagram]

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>From line</td>
<td>Index of first row to begin selection, inclusive.</td>
<td>Integer only. Mandatory.</td>
</tr>
<tr>
<td>To line</td>
<td>Index of last row to be selected, inclusive.</td>
<td>Integer only. Equal to or greater than From line. Mandatory.</td>
</tr>
</tbody>
</table>

**Replace**

**Description**

Finds one or all occurrences of a substring, which matches a specified regular expression, and replaces it with a specified value.
## Dialog Box

The Add/Edit Parsing Rule dialog box is displayed below when the **Replace** operator is selected. In addition, the dialog box displays an example using the **Replace** operator.

![Replace Operator](image)

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>Search for value or regular expression.</td>
<td>Text. Mandatory.</td>
</tr>
<tr>
<td>With</td>
<td>Replace string with value or regular expression.</td>
<td>Text. Mandatory.</td>
</tr>
<tr>
<td>From Index</td>
<td>Starting index.</td>
<td>Integer. Mandatory.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Checkbox. Select this option to replace all occurrences of the matching substrings, otherwise only the first instance is replaced.</td>
<td>Default is unchecked.</td>
</tr>
</tbody>
</table>

**Note** The value entered in this field must be 1 or higher.
**Match**

**Description**

Finds and extracts a substring, which matches a specified regular expression. If no match can be found the output buffer receives an empty string.

**Dialog Box**

The Add/Edit Parsing Rule dialog box is displayed below when the **Match** operator is selected. In addition, the dialog box displays an example using the **Match** operator.

![Figure A-5 Match Operator](image)

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>Search for value or regular expression.</td>
<td>Text. Mandatory.</td>
</tr>
</tbody>
</table>
Set

Description

Prints the results of the input and output buffers.

Dialog Box

The Add/Edit Parsing Rule dialog box is displayed below when the Set operator is selected. In addition, the dialog box displays an example using the Set operator.

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>Regular expression template to use for formatting. $_$ specifies the main output buffer.</td>
<td>Text. Mandatory.</td>
</tr>
</tbody>
</table>
Substring

Description

Extracts a substring of a specified length from a specified starting point.

Dialog Box

The Add/Edit Parsing Rule dialog box is displayed below when the Substring operator is selected. In addition, the dialog box displays an example using the Substring operator.

![Substring Operator Diagram]

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Index</td>
<td>Begin index to select.</td>
<td>Integer. Mandatory</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td>The value entered in this field must be 1 or higher.</td>
</tr>
<tr>
<td>Length</td>
<td>How many characters to select.</td>
<td>Integer. Mandatory</td>
</tr>
</tbody>
</table>
Parse Integer

Description

Uses the substring rule, and when a result is received with the substring it is converted into an integer value.

Note

If the substring operator contains any characters the parsing integer operator will fail.

Dialog Box

The Add/Edit Parsing Rule dialog box is displayed below when the Parse Integer operator is selected. In addition, the dialog box displays an example using the Parse Integer operator.

Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Validation Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Index</td>
<td>Starting index to select.</td>
<td>Integer. Mandatory</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note The value entered in this field must be 1 or higher.</td>
</tr>
<tr>
<td>To Index</td>
<td>Ending index to select.</td>
<td>Integer. Mandatory</td>
</tr>
</tbody>
</table>
Parse Integer
APPENDIX B

Alarm Threshold Triggers

This chapter describes the pre-defined alarm threshold triggers available for defining TCA alarms that are displayed in the Trigger tab of the Add TCA dialog box. For each alarm threshold trigger its name, description, and the unique fields displayed in the dialog box are described.

The user can define multiple alarms for the same soft property. The alarm is displayed in the ticket pane of the NetworkVision window.

A counter value, as described in this chapter, is a numeric value that always increases.

For more information about the Add TCA dialog box see Defining the TCA Alarms Parameters, page 2-16.

- Value Equal, page B-1—Describes the Value Equal threshold type.
- Value Not Equal, page B-2—Describes the Value Not Equal threshold type.
- Upper Threshold, page B-2—Describes the Upper Threshold type.
- Lower Threshold, page B-3—Describes the Lower Threshold type.
- Upper Rate, page B-4—Describes the Upper Rate threshold type.
- Lower Rate, page B-5—Describes the Lower Rate threshold type.

Value Equal

The alarm condition is reached when the soft property value is equal to the value defined in the “Alarm Value” regardless if it is numeric or not.

When the Value Equal threshold type is selected from the Trigger dropdown list of the Add TCA dialog box the Trigger tab is displayed.

The following fields are displayed in the Trigger tab when the Value Equal threshold type is selected:

- To value—The target value.
- Trigger alarm only if change persists more than—Select this option to trigger the alarm if the alarm criteria persist for the defined period. The time period is defined in milliseconds in the trigger alarm field. For example, if CPU usage is over 85% (the alarm criteria) and this persists for more than one minute (the defined period), then the alarm is triggered. Considering that the soft property polls the device every x seconds, if the defined period is less than x, this will be meaningless.
Value Not Equal

The alarm condition is reached when the soft property value is NOT equal to the value defined in the “Alarm Value” regardless if it is numeric or not.

When the Value Not Equal threshold type is selected from the Trigger dropdown list of the Add TCA dialog box the Trigger tab is displayed as follows:

The following fields are displayed in the Trigger tab when the Value Not Equal threshold type is selected:

- **To value**—The target value.
- **Trigger alarm only if change persists more than**—Select this option to trigger the alarm if the alarm criteria persist for the defined period. The time period is defined in milliseconds in the trigger alarm field.

Upper Threshold

The upper threshold value, which when crossed triggers the alarm for the defined numeric properties. This threshold trigger must receive a numeric value. In order to receive a numeric value the parse integer rule must be applied on the soft property as an ending rule. For more information about parsing integers see Appendix A, “Parsing Operators/Rules”.
When the **Upper Threshold** type is selected from the **Trigger** dropdown list of the Add TCA dialog box the **Trigger** tab is displayed as follows:

**Figure B-2  Trigger Tab - Upper Threshold**

![Trigger Tab - Upper Threshold](image)

The following fields are displayed in the **Trigger** tab when the **Upper Threshold** type is selected:

- **Trigger alarm when value is above**—The value which when crossed generates the alarm.
- **Clear alarm when value is below**—The value which when crossed (when going back) clears the alarm.
- **Trigger alarm only if change persists more than**—Select this option to trigger the alarm if the alarm criteria persist for the defined period. The time period is defined in milliseconds in the **trigger alarm** field.

**Lower Threshold**

The lower threshold value, which when crossed triggers the alarm for the defined numeric properties. This threshold trigger must receive a numeric value. In order to receive a numeric value the parse integer rule must be applied on the soft property as an ending rule. For more information about parsing integers see Appendix A, “Parsing Operators/Rules”.
When the **Lower Threshold** type is selected from the **Trigger** dropdown list of the Add TCA dialog box the **Trigger** tab is displayed as follows:

**Figure B-3  Trigger Tab - Lower Threshold**

The following fields are displayed in the **Trigger** tab when the **Lower Threshold** type is selected:

- **Trigger alarm when value is below**—The value which when crossed generates the alarm.
- **Clear alarm when value is above**—The value which when crossed (when going back) clears the alarm.
- **Trigger alarm only if change persists more than**—Select this option to trigger the alarm if the alarm criteria persist for the defined period. The time period is defined in milliseconds in the **trigger alarm** field.

## Upper Rate

The upper rate trigger is used for checking the counter value changes over a period of one second. When the specified rate is crossed it triggers the alarm for the defined numeric property. When this is used together with the **Trigger alarm only if change persists more than** option, described in **Upper Threshold, page B-2**, you can check that the rate is maintained above the specified value over time.

**Note**

The calculation for the "rate every one second" is as follows, if the property is sampled every $x$ seconds the calculation will be the *current value* less the *previous value* divided by $x$ seconds.

This threshold trigger must receive a numeric value. In order to receive a numeric value the parse integer rule must be applied on the soft property as an ending rule. For more information about parsing integers see **Appendix A, “Parsing Operators/Rules”**.
When the **Upper Rate** threshold type is selected from the **Trigger** dropdown list of the Add TCA dialog box the **Trigger** tab is displayed as follows:

*Figure B-4 Trigger Tab - Upper Rate*

The following fields are displayed in the **Trigger** tab when the **Upper Rate** threshold type is selected:

- **Trigger alarm when value is above**—The value which when crossed generates the alarm.
- **Clear alarm when value is below**—The value which when crossed (when going back) clears the alarm.
- **Trigger alarm only if change persists more than**—Select this option to trigger the alarm if the alarm criteria persist for the defined period. The time period is defined in milliseconds in the **trigger alarm** field.

**Lower Rate**

The lower rate trigger is used for checking the counter value changes over a period of one second. When the specified rate is crossed it triggers the alarm for the defined numeric property. When this is used together with the **Trigger alarm only if change persists more than** option, described in **Upper Threshold**, page B-2, you can check that the rate is maintained below the specified value over time.

*Note*

The calculation for the “rate every one second” is as follows, if the property is sampled every $x$ seconds the calculation will be the *current value* less the *previous value* divided by $x$ seconds.

This threshold trigger must receive a numeric value. In order to receive a numeric value the parse integer rule must be applied on the soft property as an ending rule. For more information about parsing integers see **Appendix A, “Parsing Operators/Rules”**.
Lower Rate

When the Lower Rate threshold type is selected from the Trigger dropdown list of the Add TCA dialog box the Trigger tab is displayed as follows:

Figure B-5 Trigger tab - Lower Rate

The following fields are displayed in the Trigger tab when the Lower Rate threshold type is selected:

- **Trigger alarm when value is below**—The value which when crossed generates the alarm.
- **Clear alarm when value is above**—The value which when crossed (when going back) clears the alarm.
- **Trigger alarm only if change persists more than**—Select this option to trigger the alarm if the alarm criteria persist for the defined period. The time period is defined in milliseconds in the trigger alarm field.
Regular Expressions

This section is based on the documentation of the package GNU RegExp.
A regular expression consists of a character string where some characters are given special meaning with regard to pattern matching. Regular expressions have been in use from the early days of computing, and provide a powerful and efficient way to parse, interpret and search and replace text within an application.

Supported Syntax

Within a regular expression, the following characters have special meaning:

Positional Operators

\^ matches at the beginning of a line
$ matches at the end of a line
\A matches the start of the entire string
\Z matches the end of the entire string
\b matches at a word break (Perl5 syntax only)
\B matches at a non-word break (opposite of \b) (Perl5 syntax only)
< matches at the start of a word (egrep syntax only)
> matches at the end of a word (egrep syntax only)

One-Character Operators

. matches any single character
\d matches any decimal digit
\D matches any non-digit
\n matches a newline character
\r matches a return character
\s matches any whitespace character
\S matches any non-whitespace character
\t matches a horizontal tab character
\w matches any word (alphanumeric) character
\W matches any non-word (alphanumeric) character
\x matches the character \x, if x is not one of the above listed escape sequences.

Character Class Operator

[abc] matches any character in the set a, b or c
[^abc] matches any character not in the set a, b or c
[a-z] matches any character in the range a to z, inclusive
A leading or trailing dash will be interpreted literally.
Within a character class expression, the following sequences have special meaning if the syntax bit RE_CHAR_CLASSES is on:
[\alnum:] Any alphanumeric character
[\alpha:] Any alphabetical character
[\blank:] A space or horizontal tab
[\cntrl:] A control character
[\digit:] A decimal digit
[\graph:] A non-space, non-control character
[\lower:] A lowercase letter
[\print:] Same as graph, but also space and tab
[\punct:] A punctuation character
[\space:] Any whitespace character, including newline and return
[\upper:] An uppercase letter
[\xdigit:] A valid hexadecimal digit

Subexpressions and Backreferences
(abc) matches whatever the expression abc would match, and saves it as a subexpression. Also used for grouping.
(?:...) pure grouping operator, does not save contents
(?#...) embedded comment, ignored by engine
\n where 0 < n < 10, matches the same thing the nth subexpression matched.

Branching (Alternation) Operator

a|b matches whatever the expression a would match, or whatever the expression b would match.
Repeating Operators

These symbols operate on the previous atomic expression.

? matches the preceding expression or the null string

* matches the null string or any number of repetitions of the preceding expression

+ matches one or more repetitions of the preceding expression

{m} matches exactly m repetitions of the one-character expression

{m,n} matches between m and n repetitions of the preceding expression, inclusive

{m,} matches m or more repetitions of the preceding expression

Stingy (Minimal) Matching

If a repeating operator (above) is immediately followed by a ?, the repeating operator will stop at the smallest number of repetitions that can complete the rest of the match.

Lookahead

Lookahead refers to the ability to match part of an expression without consuming any of the input text. There are two variations to this:

(?=foo) matches at any position where foo would match, but does not consume any characters of the input.

(?!foo) matches at any position where foo would not match, but does not consume any characters of the input.

Unsupported Syntax

Some flavors of regular expression utilities support additional escape sequences, and this is not meant to be an exhaustive list. In the future, gnu.regexp may support some or all of the following:

(?mods) inlined compilation/execution modifiers (Perl5)

\G end of previous match (Perl5)

[.symbol.] collating symbol in class expression (POSIX)

[=class=] equivalence class in class expression (POSIX)

s/foo/bar/ style expressions as in sed and awk (note: these can be accomplished through other means in the API).